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Audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and
use the audio interface and control surface functions of the R24 with a DAW and other
software.

Functions of the audio interface and control surface

[INPUT 1-8] jacks
Guitars and other
musical instruments, £
built-in stereo mic A7

[PHONES] jack
Playback device like
headphones or an
audio system

o o [OUTPUT] jacks
Stereo system,

speakers with built-in

amplifiers, etc.

USB Cable

DAW software

Cubase LE etc.

Audio driver

I Audio interface

The R24 has numerous inputs and outputs
and it can be used as a Hi-Speed USB
(USB 2.0) audio interface with 8 inputs
and 2 outputs at quality up to 24-bit/96
kHz. Effects can be used when the sam-
pling rate is 44.1 kHz, and the unit can be
powered by a computer’s USB bus.

Il Control surface functions

On-board control surface functions can be
used to control DAW software on a com-
puter via USB. Transport operations, in-
cluding playback, recording and stopping,
and physical control of the DAW faders
are possible. Furthermore, various other
DAW software functions can be mapped
to the F1~F5 keys (assignable functions
depend on the DAW used).




l Supports input from a variety of
sources, including guitars, mics and
line level instruments

The 8 onboard jacks accept XLR and
standard phone plugs and include one
high-impedance input and two inputs with
phantom power (24V or 48V).

Many sources are supported from high-
impedance guitars and basses to dynamic
and condenser microphones and line-
level devices like synthesizers. In addition,
built-in high- performance condenser
microphones are convenient for recording
acoustic guitars and vocals.

l Versatile effect functions

Built-in insert effects can be applied to
specific channel paths, and two-types
of send/return effects work via the mixer
send/return. These effects can be applied
when recording, of course, but they can
also be applied to only the monitor output.
For example, when recording vocals, you
can apply reverb only to the monitor sig-
nal to make singing easier.

Il Comprehensive built-in mixer

Using the R24’s mixer, you can make a
mix for monitoring. When simultaneously
recording guitar and vocals, for example,
you can adjust volume balance, panning
and reverb levels.

Moreover, you can also adjust the balance
between the built-in mixer and the sound
sent from a computer.

B Multifunction tuner

In addition to standard chromatic tuning,
the on-board multifunction tuner also sup-
ports 7-string guitar, 5-string bass and
various drop tunings.
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Cubase LE installation overview

To use the R24 with DAW software, after installing that software, a driver must be
installed and set to recognize it. We explain how to do this with Cubase LE.

@ Audio interface ® Control surface
By using the R24 between a computer and Using the faders and keys on the R24, you can
external audio devices and instruments, their control transport operation and mixing in digi-
signals can be recorded using a DAW or other tal audio workstation (DAW) software on your
software. Instruments and mics that require computer.

Hi-Z or phantom power can also be connected.

[ Install DAW software Reference: "Cubase LE Startup Guide" )
Cubase LE
( Install driver Reference: "Cubase LE Startup Guide" )

ZOOM R16/R24 audio driver
v

Connect R24 to computer P.7

N
N

Audio interface setup

v

DAW software setup

[ Device setup Reference: "Cubase LE Startup Guide" )

ZOOM R16/R24 audio driver

( Control surface setup P9, 29~ )

Mackie Control

( Recording P15 )




R24 Audio Interface system requirements

R24 Audio Interface system
requirements

Windows
Windows® XP SP2 or later (32-bit)
Windows® Vista SP1 or later (32-bit, 64-bit)

Cubase LE installation guide

Please refer to the Cubase LE Startup Guide
for detailed instructions for installing the R16/
R24 audio driver and Cubase LE.

Windows® 7 (32-bit, 64-bit)

32-bit: Intel® Pentium® 4 1.8 GHz or faster

64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster

64-bit: RAM 2 GB or faster

Intel Mac

OS X 10.4.11 or later/10.5 or later/10.6
Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

e USB hubs are not supported.

e Intel® chipsets recommended.

Note about descriptions and images

This manual was prepared based on use with Win-
dows systems. Special functions related to Mac OS
X are indicated separately.

The screen images are of the Windows version.

About trademarks

® The SD symbol sz and SDHC symbol are trademarks.

» Windows®, Windows® XP, Windows Vista® and Windows 7® are registered trademarks of Microsoft®
in the USA.

» Macintosh® and Mac OS® are trademarks of Apple Inc.

¢ Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH Inc.

o Intel® and Pentium® are trademarks of Intel Corporation.

* MACKIE Control is a registered trademark of LOUD Technologies.

¢ |ogic is a trademark of Apple Inc.
* SONAR is a trademark of Cakewalk, Inc.

¢ Ableton Live is a trademark of Ableton AG.

* Digital Performer is a registered trademark of Mark of the Unicorn.

¢ All other product names, registered trademarks, and company names mentioned in this documentation
are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
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Connecting and disconnecting in audio interface mode

This is an overview of connecting and disconnecting the R24 to a computer with a USB
cable. For details, see the included Cubase LE Startup Guide guide.

Connecting the R24to a computer R24 setup and connection
for the first time Follow these procedures when connecting again.
‘I Install the Cubase LE DAW ‘I UB  Press USB.
software on the computer.
2 Install the audio driver on the 2 Select i
computer from the included .
CD'ROM USB Change
AUDID I-F 3 menu
Installation and setup details [ A
[II% Reference: "Cubase LE Startup Guide" } v
4 Connect the R24 to a computer.
( R24 setup and connection )
Setup the DAW software.
3 Select .
¢ Device setup ) AUDI0 INTERFACE [EEESINS
[l]%’ Reference: "Cubase LE Startup Guide" ] SETTING  [Continue mim
EXECUTE | F
(Control surface setup P9 ) v

Mackie Control

Press ENTER.

| NOTE

e The ZOOM R16/R24 audio driver is essential for
using the R24 as an audio interface with DAW
software such as Cubase LE.

When downloading it, follow the included instal-
lation guide to install it correctly.

e Download the latest R24 audio driver from the
Zoom Corporation website.
http://www.zoom.co.jp/




Connect the USB cable to the R24.

RE!
AUDI0 INTERFACE

Sanple Rate

Connect the USB cable to the
computer.

El H
Ja—
¢ — )

USB icon appears when connection completes.

[

Sanple Rate
96, 8kHz

( Disconnecting )

] Press the D below uss

2 Select

Terminate Change

menu

Are You Sure? A
\

3 Disconnect the USB cable

| NOTE

Select CONTINUE to use the same settings as last time.
¢ INSERT EFFECT settings

* SEND RETURN EFFECT settings

* Mixer settings

* TUNER settings

Select RESET to restore default settings for each item.

e The audio interface and control surface func-
tions of the R24 can be used by drawing power
through a USB cable from the USB bus.

e We recommend always using the latest R24
system software.

e When using phantom power, we recommend
using batteries or an AC adapter even when the
unit is used as an audio interface.

or [].
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Using control surface functions

When using the R24 connected by USB as an audio interface, the R24 keys and faders
can be used to control Cubase LE’s transport and mixer.

About the control surface

Control surface setup

In control surface mode the keys and knobs on
the R24 can be assigned to particular Cubase
LE functions.

[ Transport section P10 ]

P11 ]
P11 ]

[ About banks

[ Fader section

] HINT

Assigning keys

For a list of functions that can be assigned to the
knobs and keys of the R24, as well as other trans-
port/function keys that are supported by Cubase
LE, please consult the “Control surface functions
quick reference guide” in this manual.

= Reference: Control surface functions quick -
[ reference guide P14

{ See R24 setup and connection steps 1-5 on P7~8

6 Then, launch Cubase LE.

From the Cubase LE “Devices”
menu, select “Device setup...”

aAolol> e Jx:

VST Performance
Video Window
Vigtual Keyboard

Show Panel

Device Setup.

Open the “Device Setup...” window.

8 At the top left of the Device setup
window [+], [-] and [|<] buttons
appear. Click the [+] and select
“Mackie Control”

€ deeesawr =
TEn

Oupiloency:  7.302ms
Sae Rote A1000Hz

Advanced Options Sl o Dofaits

ormal ] Audio ity
Mol Prc

PETETIS  0ii Pielosd

9 Set the MIDI input and output

MIDI input:
MIDI output:

ZOOM R16_R24
ZOOM R16_R24



Transport section

By setting up the control surface, the R24’s
transport section keys can be assigned to indi-
vidual functions in Cubase LE.

[F1]key [F2] key [F3]key [F4]key [F5]key

[_lﬂ m@ [_ij l_}wj mé@
| | B ]

CICCIG0C]

[REW] key [FFlkey  [STOPlkey [PLAY]key [REC]key

|[enuew 9oeLIS1UI OIpNY I
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Fader section operation

Using the faders and status keys of the fader section, you can adjust the volume of
corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

About banks

Operating the fader section

After setting up control surface operation, the
main parameters of Cubase LE can be oper-
ated using the R24’s fader and status keys.

A group of tracks operated by the faders and
status keys is called a “bank.” With the R24,
one bank of 8 adjacent tracks can be con-
trolled.

For example, if fader 1 is assigned to Cubase
LE track 1, tracks 1-8 can be controlled as
shown in the following diagram.

Control 1 2 3 4 5 6 7 8
Track 1 T2 T3 T4 T5 Tr6 T7 T8

As the diagram shows, when tracks 1~8 are
selected, pressing the [9~16tr (Bank>)] key
once switches the assignments as shown be-
low.

Control 1 2 3 4 5 6 7 8
Track ™9 Tr10 Tr11 12 Tr18 Tr14 Tri15 Tr16

1~8Tr
o[

1~8Tr (< BANK) key
Tracks (channels) assigned to the fader section are
moved backward by eight tracks.

9~16Tr
o[

9~16Tr (BANK >) key
Tracks (channels) assigned to the fader section are
moved forward by eight tracks.

‘I Assign the Cubase LE tracks
(channels) that you want to control
to the fader section.

2 Use the faders to control the

volumes of the corresponding
tracks.

The faders control the volumes of their re-

spective tracks. Change the master volume
by moving the [Master] Fader.

PLAY/MUTE/REC |

3 To change the function of the

status keys for all the tracks,
press the soft key for the desired
function.

[ % ]
AUDID INTERFACE
Sanple Rate

z




R24 level meters

(Audio interface use)

179717
I
8/16/24

Each level meter other
than the MASTER displays
the signal immediately
before sending it to the

MASTER

The master level
meter displays the
returning signal from
the computer.

computer.

Checking DAW recording levels
” (in the
; ! (signal with
effect) or * (no effect) to send
signals to the computer with or without
being processed by the insert effects.
The recording levels of the sent signals are dis-
played on the level meters. The signal shown
on the master level meter differs from that
shown on each level meter.

] meny) to

% _I_ Red light Adjust the levels so that the
(clipping) red (0 dB) clipping indicators
q2— — on the meters do not light.

12
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Setting the function keys

The five keys above the transport keys can be used as function keys (F1~F5) and

assigned as desired.

Function key setup

Open the “Device setup...” dialog
in Cubase LE.

MIDI [~
© MIDI Port Setup
te Devices. 10880 ms
7302 ms
41000 He

Mackie Control

Transport

Remaining Record Time Display.
Time Display

Video

0 Video Player s Set to Defaults

2 Select “Mackie Control”.

Commands can be assigned using the three

columns displayed on the right side of the window.

From the “Button” column choose
the function key (F1~F5) to be
assigned a Cubase LE function.

Mackie Control

Click on the “Category” column for
that control.

~] ASIO Driv

n Application is in Backerol

Choose the type of Cubase LE
function from the Category pop-up
menu.

Mackie Control
ol

Click on the “Command” column
and select the desired Cubase LE
function from the pop-up menu.

The items in this pop-up menu will differ depending
on the category chosen.

Press the “Apply” button.

W Feley Tk

7

= |

[ ok J[ Cencel




Control surface functions quick reference guide

These functions work with Cubase LE, Cubase, Logic Pro, SONAR, Ableton Live and
Digital Performer.

Status keys

Faders

MASTER Fader

Soft keys

Cursor keys

DIAL

REW key

FF key

STOP key

PLAY key

REC key

AUTO PUNCH 1/0 key

A-B REPEAT key

|t (marker) key

| (marker) key

MARK/CLEAR key

1-8Tr key

9-16Tr key

Turns mute, solo or record arming on/off for the track
Controls the volume of the corresponding tracks

Master volume operation

Change functions of status keys/End connection (Ei41T)
Performs the same functions as the computer arrow keys'
Moves the project cursor position?

Rewind

Fast forward

Stop

Play

Record

Depends on the [F1] key setting

Depends on the [F2] key setting

Depends on the [F3] key setting

Depends on the [F4] key setting

Depends on the [F5] key setting

Moves one bank forward

Moves one bank backward

Scrolls window in Digital Performer
2No function in Digital Performer

|enuew a9e4I81UI OIpNY I

14



|enuew 9oeLI81UI OIpNY

15

Recording with Cubase LE

In this chapter, we explain how to record into Cubase LE using the R24.

Create a new project

Copy the ZOOM R24 project templates
to the computer.

From the CubaseLE_template folder on the CD
included with R24, copy the templates to the
location where Cubase LE is installed.

Windows

C:\Program Files\Steinberg\Cubase LE H\
templates

Macintosh

/Applications/CubaseLE B.app/Contents/
templates/

‘I Launch Cubase LE.

ARSI

2 Choose “New Project” from the File
menu.

Choose a new project template from the New
Project Window.

New Project,

Create a new project

After copying the R24 project templates to
the designated folder, the R24 project tem-
plates will be displayed when creating a new
project. By choosing these templates you will
be able to easily create projects with audio
track input and output settings already ar-
ranged for the R24.

New Project z|

Templates:

|

Ermpty

GLE - 16 MIDI Tracks

GLE - 4 Steren 8 Mono Audio Track Recorder
GLE - Cubaze Synthe On Inztrument Tracks
GLE - Mastering Setup

GLE - Podoasting

default

Z00M R16_R24 4Mono 25teren Recording
Z00M R16_R24 45tereo Recording

Z00M R16_R24 8Mono Recording

<

[ OF. ] [ Cancel

Template names and details

ZOOM R16_R24 8Mono Recording

Project with Cubase LE mono tracks 1~8 assigned
to R24 INPUTS 1~8

ZOOM R16_R24 4Stereo Recording

Project with Cubase LE stereo tracks 1~4
assigned to R24 INPUTS 1/2 ~ 7/8

ZOOM R16_R24 4Mono 2Stereo Recording

Project with Cubase LE mono tracks 1~4 assigned
to R24 INPUTS 1~4 and Cubase LE stereo tracks
5~6 assigned to R24 INPUTS 5/6 and INPUTS 7/8



Set the save location and click the
“OK” button (“Choose” button on
Mac OS X).

The project file save location window is displayed.

Select directory |z Z|

Set Project Folder

=] a Desktop

D Iy Docurments

= 5) My Computer
& 31 Floppy (A5
|- % Local Disk ()
-age Local Disk (D)
Local Disk (E:) =
g Local Disk (F:)
&g Local Disk (5]
-age Local Disk (H:)
g Local Disk (11}
&g Local Disk ()
e CIOOOIM i

|3

W

This will create a new project and the project
window where most Cubase LE operations are
conducted will open.

{+ Cubase LE 5 - [Cubase LE 5 Project - Untitledl]

4> File Edit Project Awdic MIDI Media Transport Devices|

Audic 01 (e

B
steren

Create a new audio track

Set-up the audio tracks that were
made as follows.

To add a new audio track, select “Add Track” from
the “Project” menu and then choose “Audio” from
the sub-menu that appears.

Inspector area allows setting of detailed track
information

If the inspector is not shown, click
here to show/hide the inspector

Select the track input/output bus.

The names of the R24 busses assigned in
the VST Connections (Devices menu) will be
displayed.

Click here to choose a different bus from the

menu.

] NOTE

The inspector displays information about the track
currently selected. If it does not display anything
click on a track to see that track’s status.

16
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Recording With Cubase LE

Connect an instrument

Connect an instrument such as
a guitar to an R24 INPUT jack and
choose an effect patch.

The chosen effect patch will be applied to the signal
and recorded on the computer via the USB port.

See the following for information about how to
choose the R24 input signal.

1> Reference: R24 Operation Manual
Selecting an input signal
Selecting an effect patch

Select “Mixer” from the Cubase LE
“Devices” menu.

Edit Project Audio MIDI Media Transport (Devices) Window Help

MIDI Device Manager

Mackie Control

Micer =

Plugein Information
VST Connections "
VST Performance F2
Video Window 8
Virtuel Keyboard Alt=K

[[m [ 5 Audio 01
e @@ [alw

Show Panel

Device Setup..

The mixer window opens, showing the channels
corresponding to the created tracks and the
master channel.

8 Enable the track for recording.

Channel corresponding

to an audio track Master Channel

]
=l
=]
lul
®
=
Lol
(=)
9]
®

Click the record enable
button. It will light red
and recording will be
enabled.

Click the Monitor
button until it lights
orange.

| HINT

When the Monitor button is lit, the audio track input
level will be displayed in the level meter next to the
fader. When the light is off, the audio track output
level will be displayed.




Adjust the recording level

While playing the instrument,
adjust the R24 input level and set
the Cubase LE recording level.

Level Meter

The recording level for Cubase LE can be checked
by viewing the level meter of the corresponding
channel of the recording-enabled track. Please set
it as high as possible without making the meter
peak.

When adjusting the level, do not move the Cubase
LE fader, but instead use the fader and adjust the
gain on the R16.

] NOTE

e |f the Monitor button is on, the R24 input signal
and the signal returning to the R24 via the
computer will both be output from the R24 at
the same time. This can create a flanger-like
sound. To monitor accurately while adjusting the
recording level, turn the BALANCE knob toward
DIRECT.

e The meter above shows the signal level after it
has been processed internally by Cubase LE.
For this reason, a slight delay might occur from
the time a string is plucked until the level meter
moves; this is not a defect.

‘I After adjusting the recording level,
click the Monitor button to turn off
the light.

Monitor
button

This turns off display of the input level, and mutes
the signal from the computer to the R24.

When the Monitor button is off, the signal just
before it is sent to the computer can be monitored
from the R24 PHONES and OUTPUT jacks.

Confirm that the Transport Panel is
displayed

If the Transport Panel is not displayed, select
“Transport Panel” from the “Transport” menu.

[ Cobese ES

Ele Edt Project_Audio MIDI Msdio DescesWindow _Help
T T v TrnsponP:

Locate Nt Event N
Locate Previous Event 5

1
Stat Record at Lef Locator

Metronome Setup.
Metronome On c

T

Retrospective Record Shift=Pd *

18
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Recording with Cubase LE

Recording

Check the recording (playback)

‘|2 Click the Record button on the
Transport Panel to start recording.

0:00:00.000 0:00:00.000

0:00:00.000

Stop button J \— Record button

As you play the instrument, a recorded waveform
is drawn in real time in the project window.

To stop recording, click the Stop button in the
transport panel.

Ell G

PERERDY S

‘I Lower the master channel fader.

Stereo Dut

2 Click the |< button in the Transport

Panel to return to the beginning of
the project.

K<< [ >> 2210 > | @

L

Return to the beginning of the project

3 Click the Play button in the

Transport Panel to begin playback.

KK ([ > 2210 > | @

Play button




Raise the master channel fader to a
suitable playback level.

Stereo Dut

J HINT

If no sound comes out after clicking the Play button
following recording, recheck the VST Connections
(step 6 in the Cubase LE Startup Guide).

In addition, confirm that the BALANCE control is at
the center.

Tips to improve performance

When using Cubase LE, application perfor-
mance could become extremely delayed or
error messages such as “cannot synchronize
with USB audio interface” might be dis-
played. Should such occurrences become
frequent, the following measures might im-
prove the situation.

@ Terminate programs other than
Cubase LE that are running.

In particular, confirm that many background
applications are not running.

@ Reduce the use of plug-ins
(effects, virtual instruments)

If a large number of plug-ins are running, the
computer processing capacity might not be
able to keep up. In addition, reducing the
number of simultaneous playback tracks
might be effective.

© Use the R24 AC adapter

When devices draw power from the USB
bus, on rare occasions computer perfor-
mance can suffer. Try using the AC adapter.

If the sound breaks up, please increase the
Audio Buffer Size in the Device Setup...
menu > VST Audio System window.

For details, see Step 5 of the Cubase LE
Startup Guide.

Moreover, if the application performance
is extremely slow and regular computer
operation is affected, we recommend quit-
ting Cubase LE and disconnecting the R24
USB port from the computer once, and then
reconnecting the USB port and relaunching
Cubase LE.

20
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Importing audio data into Cubase LE

Il By connecting a computer and the R24 with a USB cable and setting the R24 to
function as a card reader, you can import audio data as WAV files into Cubase LE audio

4

s tracks.

o

5 Importing by drag & drop

[0}

2

) Connect the computer and the R24 4 Launch Cubase LE.

g DEVICE port with a USB cable.

- USB 5 Open the Cubase LE project into
2 D Press USB. which you want to import audio

data.

6 Open the R24 SD card from the
computer and open the “AUDIO”
folder of the project from which you
want to import audio data.

—
3 )=[1 + Compur » Remorsb Dik(E) + ZOOMTDN » PROIECT + PR » AIO T
T e, AL
e oae
Vono.om g
Mono o 1
3 Monom2 o
Moo 013 g
MONo o 1o
« | nonoss g
v 1

21



Select the file (or files) that you
wish to import from the “AUDIO”
folder and drag and drop them into
the Cubase LE project window.

@vv‘ » Computer » Removable Disk (E) » ZOOM_R24 @PROJECT » PRIOO

Name
7 MONO-000
. MONO-001
2 MONO-002
2. MONO-003
2. MONO-004
2 MONO-005

More »

Folders v
B Desktop
&I Administrator
Public

When a file is dragged and dropped, a
window will open asking how Cubase
LE should place the file.

When dragging multiple files at one
time, select either “Different Tracks” or
“One Track” as the import method.

Generally, select “Different Tracks” to automati-
cally create one track for each file. The files will
be arranged vertically in the project window.
Select “One track” to create one track with the
audio files arranged horizontally.

4 CubaseLES =7

@_ Thsert abjects on one track or insert sach on diffarsnt track?

Different tracks

This window where you can select the import
method appears.

9

In the “Import Options” window
click the “Copy Files to Working
Directory” check box, and click the
OK button.

< Import Options

3 i s 16 WerKTne Dty
W Corvert and Gopy to Project If Needed

M Do ot Ack seain

[ Hep | [ o J[ cancel

The audio files are loaded into
Cubase LE tracks.

| HINT

The USB cable can be connected even when the
computer or the R24 is on.

If the R24 is connected when off, it can be run on
USB bus power.

Project data is stored in folders for each project
in the PROJECT folder in the ZOOM_R24 folder.
Audio recordings are stored as WAV files in
the “AUDIO” subfolders of each project folder.
Each AUDIO folder also contains a file called
“PRJINFO.TXT” that lists the names of files
assigned to tracks.

Master tracks and stereo tracks are stereo
WAV files.

To copy a WAV file from a computer, copy it to
the AUDIO subfolder of the desired project folder
Use the R24 to assign the files to tracks.

22
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Importing audio data into Cubase LE

Using the “Import” command

Connect the computer and the R24
DEVICE port with a USB cable.

|[enuew 9.9 Ul OIPNY I

2 ﬁ Press USB.

4 Launch Cubase LE.

23

Open the Cubase LE project into
which you want to import audio
data.

6 From the Cubase LE “File” menu
select “Import” and “Audio File...”

The “Import Audio” window opens.

ECITCEEYAAS 20 @




Select the desired audio file (or
files) from the “AUDIO” folder of
the project from which you wish to
import. Click “Open.”

2/ MONO-000
] MONO-001

| MONO-002

2 MONO-003
| MONO-004
v 2/MONO-005

. LIPRINFO

Importing files will cause the “Import Options”
window to appear.

In the “Import Options” window
click the “Copy File to Working
Directory” check box, and click the
OK button.

< Import Optiens

s Files 16 Wrking Directory
W Convert and Gopy to Project i Needsd

B Co not Ask again

| Heb | [ ox J| ocawe |

When a file is imported, a window
will open asking how Cubase LE
should place the file.

When importing multiple files at
one time, select either “Different
Tracks” or “One Track” as the
import method.

The audio data is assigned to one or more Cubase
LE tracks.

«* CubaseLES =]

@ Insert objects on one track o incert each on different track?

Different tracks.

Generally, select “Different Tracks” to
automatically create one track for each
file. The files will be arranged vertically in
the project window.

Select “One track” to create one track
with the audio files arranged horizontally.

| HINT

The USB cable can be connected even when the
computer or the R24 is on.

If the R24 is connected when off, it can be run on
USB bus power.

Project data is stored in folders for each project
in the PROJECT folder in the ZOOM_R24 folder.
Audio recordings are stored as WAV files in
the “AUDIO” subfolders of each project folder.
Each AUDIO folder also contains a file called
“PRJINFO.TXT” that lists the names of files
assigned to tracks.

Master tracks and stereo tracks are stereo
WAV files.

To copy a WAV file from a computer, copy it to
the AUDIO subfolder of the desired project folder
Use the R24 to assign the files to tracks.

24
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The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R24’s internal
mixer. In addition, you can adjust the balance of the internal mixer and the sound from

the computer.

Volume, reverb send, pan

Stereo link

You can be adjust the reverb send, pan, vol-
ume and stereo link settings as in recorder
mode.

Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL)

PAN/EQ menu

VOLUME
Adjust the volumes of INPUTS 1~8.

Ineutl

A L1aa
REU SEHD 0FF

0~127 (increments of 1)
Default value: 100

UOLUME |8

=

REV SEND
Adjust the reverb send levels of INPUTS 1~8.

Inputl

Ml L1aa

0~100 (increments of 1)

E:El-.-l I_:IEH[:' |Ei Defaul lue: 000
qLUTE Reverb ony afects the
=T LIME monitored signal (as in

recording mode).

PAN (BALANCE)

Adjust the pan for INPUTS 1~8.

Ineutl

Liba

L100~R100
(increments of 2)
Default value: Center
(as in recording mode)

25

Link even and odd numbered INPUTS to handle
them as stereo pairs.

Inputls2

A
ST LIMK [On

On/Off0

Default setting: Off

By setting up a stereo link, volume, reverb send and pan
track parameters can be shared by pairs of even and odd
inputs simultaneously (as in recording mode).
(Reference: Operation Manual)

Balance knob

In audio interface mode, the balance of the in-
put monitoring signal and the signal from DAW
software (the computer) can be adjusted with
the BALANCE knob.

BALANCE

Left Right
Only the INPUT Only the DAW
1~8 signals stereo signal
MASTER CLICK

The reverb send, pan, volume and stereo link
settings are all saved when you terminate )l
audio interface mode and can be used again the
next time.




Tuner

The R24 tuner can be used as when recording. For details, see the Operation Manual.

Chromatic tuner I HINT
TOOL > ¥
e The default value of the standard pitch is 440 Hz.
TOOL e Tuners other than the chromatic tuner can also
] D Press TOOL. be used.
Reference: Operation Manual )
e i | NOTE
A Tuner settings are saved when you terminate (E:417)
v audio interface mode and can be used again the
next time.

ENTER.

I Reference: Operation Manual

Tuner
To change the standard pitch, To change the tuner type, press
press the D beneath EfA. the D beneath .

CHROMATIC TUNER

Change the Change the
standard pitch tuner type
A
A\

26

|[enuew 9oeLIS1UI OIpNY



|[enuew 9.9 Ul OIPNY I

Effects in audio interface mode

The R24’s insert and send-return effects can both be used when the sampling
frequency is set to 44.1 kHz. Basic operation is the same but there are a few

differences in the menus.

Insert effect

Send return effect

As in recording mode, you can select the insert
location and the insert effect algorithm, as well
as the effect patches to be applied to the sig-
nal being recorded.

INSERT EFFECT menu

Select the insert location

As in recorder mode, use the
menu to change the patch and use the i+

menu to set the FiL! level that ad-
justs the reverb depth.

Setting the reverb send level

Insert on any INPUT 1~8.

INSERT EFFECT

THSERT | REVERE

(Reference: Operation Manual )

Apply the effect only to monitoring

The effect can be set to only be applied to the monitoring
signal and to not affect signals recorded in DAW software.

INSERT EFFECT

REC SIG (it
THSERT | KEUERE

(Reference: Operation Manual )

27

PAH L1684
WL SEMD |8

(Reference: Operation Manual )
(Reference: Audio interface manual — Mixer )

| NOTE

e Effects can only be used when the sampling rate
is 44.1 kHz. At all other times it is turned OFF.

e Insert and send return effect settings are saved
when you terminate T) audio interface
mode and can be used again the next time.




Working with patches

After making many changes, you can restore a patch to its pre-edited settings by
initializing it. This will return it to its factory preset condition.

Patch operations
For both insert and send return effects

Patch operation menu

Selecting insert effect/reverb patches
To use an insert effect, select an algorithm and
a patch.

To use a send reverb effect, select a patch.
(Reference: Operation Manual)

Editing patches (EDIT)

By adjusting effect module parameters and
levels, you can create the desired result. (Refer-
ence: Operation Manual )

Importing patches (IMPORT)

All effect algorithms (and reverb patches) or
a single one can be imported from a selected
project on the R24.

(Reference: Operation Manual )

In audio interface mode, one complete set of effect
data is saved for the mode. There are no project
based settings.

Saving patches (SAVE)

Edited patches can be saved.
(Reference: Operation Manual )

Initializing patches (INITIAL)

Restores patches to their original factory set-
tings (only available in audio interface mode).

Changing patch names (RENAME)
The name of the currently selected patch can
be changed.

Patch initialization (factory reset)

EFFECT >

EFFECT
] D Press EFFECT.

Turning effects on/off

Insert effect
Press the D beneath IGHTAL.

Send return effect

Press the

D beneath EEAL

The following example is of an insert
effect.

Turn the effect
INSERT EFFECT

Select* )
PATCH INITIAL

Change

menu
Are You Sura? A
v
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Control surface setup for other DAWs

I You can set up the R24 as a controller for use with a variety of DAW software besides

|enuew 9oeLIS1UI OIpNY

[ Logic

Control surface setup

Select “Preferences” >
“Control surfaces” > “Setup...”
from the “Logic Pro” menu.

This opens the “Setup” window.

Click on the top left “New” and
select “Install” from the pull-down
menu.

Select “Mackie Designs/Mackie
Control/Logic Control” from the list
in the “Install” window and click
the “Add” button.

“Mackie Control” will be added to
the setup window.

Click the “Mackie Control” icon.
Then, from the top of the list at the
left set “Out Port” and “Input” to
“ZOOM R16_R24” using their pull-
down menus.

2
3

Cubase LE. Please refer to the manual for the software that you are using.

Function key setup

Select “Preferences” >

“Control surface” > “Controller
Assignments...” from the “Logic
Pro” menu.

This opens the “Controller
Assignments” window.

From the “Zone” column select
“Control Surface: Mackie Control.”

Change the functions as you like.
Controls F1~F5 correspond to the
F1~F5 keys on the R24.

The above procedures are for Logic
Pro 9.

The names of the menus, for
example, might be different in a
different version of Logic.

Please refer to the manual for the
version of Logic that you are using
for details.



[SONAR ]

Control surface setup

Select “Controller/Surface” from
the “Options” menu to open the
“Controller/Surface” dialog.

If a controller/surface has already
been selected, click on the “Delete”
button to delete it.

Click the “Add” button and open
the “Controller/Surface Setup”
dialog.

Choose “Z0O0M R16_R24” from the
drop-down menu of the “Controller/
surface” column.

Select “ZO0M R16_R24” in the
input/output port column.

For Cakewalk SONAR, installation
of a control surface plug-in is
necessary. Please install it when
installing the driver.

Function key setup

‘I Choose “Option key bind” to open
the “Key bind” dialog.

2 Press “Search for the key” in

“Setup”.

3 Press the F1-F5 key that you

want to setup to see the currently
assigned function. Change that
function as necessary.

The above procedures are for
Sonar 7.

The names of the menus, for
example, might be different in a
different version of Sonar.

Please refer to the manual for the

version of Sonar that you are using
for details.

| HINT

The F1~F5 keys on the R24 are labeled as follows.

F1: AUTO PUNCH 1/0 key
F2: A-B REPEAT key

F3: | (Marker) key
F4: pp| (Marker) key
F5: MARK/CLEAR key

30
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Control surface setup for other DAWs

[ Live

|[enuew 9.9 Ul OIPNY I

—
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Control surface setup

Select “Preferences” from the
“Option” (Windows) or “Live” (Mac)
menu.

The Preferences window will open.

Click the “MIDI” setting tab on the
left side of Preferences window to
select it.

The setup window related to MIDI
will open.

Select “Mackie Control” in the pull-
down menu of the Control Surface
column.

Select “Z00M R16_R24” from the
pull-down menus of the Input and
Output columns.

In the MIDI Ports section below,
turn “On” the Remote column
button for the “Input: Mackie
Control Input (Zoom R16_R24)”
item.

Function key setup

‘I Press the MIDI button at the top
right of the main LIVE window to
open MIDI map mode.

Interface elements that can be

2 assigned will be highlighted in blue.
Click on a parameter that you want
to control.

3 Press the F1~F5 key of the R24
that you want to use to control the
selected parameter in Live.

The above procedures are for
Ableton Live 8.

The names of the menus, for
example, might be different in a
different version of Live.

Please refer to the manual for the

version of Live that you are using for
details.

J HINT

The F1~F5 keys on the R24 are labeled as follows.

F1: AUTO PUNCH 1/0 key
F2: A-B REPEAT key

F3: | (Marker) key
F4: ppei (Marker) key
F5: MARK/CLEAR key



[ Digital Performer ]

N

o O A W

~

Control surface setup

Launch the Audio MIDI Setup
application (/Applications/Utilities).

Open the MIDI Studio window
(Window > Show MIDI Window)
and confirm that “Z0O0M R24” is
displayed.

Click “Add Device.”
A “new external device” will be
added.

Click the “new external device” to
select it, and then click the “Show
Info” button.

Enter the name “R24” in the “Device
Name” field.

Click and drag the downward arrow
of the original “ZO0M R24” icon
and connect it to the downward
arrow of the “R24” icon that you
added.

Use same method to connect the
upward arrows.

Launch Digital Performer

Select “Control Surface Setup”
from the “Setup” menu to open the
Control Surface window.

Click the “+” icon in the Control
Surface window and select “Mackie
Control” from the “Driver” pull-
down menu.

] Select “Mackie Control” from the
“Unit” pull-down menu that will be
displayed at bottom.

Select “R24” from the “MIDI” pull-
down menu of the Control Surface
window and select “R24-1" from
the menu list.

11

]2 Click the “OK” button.

The above procedures are for Mac
OS X 10.6 and Digital Performer 5.

The names of the menus, for
example, might be different in a
different version of Digital Performer.

Please refer to the manual for the
version of Digital Performer that you
are using for details.

Function key setup

The functions are already assigned in Digital Performer
and cannot be changed.

AUTO PUNCH 1/0 key:
A-B REPEAT key:
| (Marker) key:
»p| (Marker) key:
MARK/CLEAR key:

Selects YES in dialog boxes
Selects NO in dialog boxes
Creates groups/track groups
No assignment

No assignment

Refer to sections about Mackie Control dialog boxes
and track groups in the manual for the version of Digital
Performer that you are using.
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